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Welcome 
 

Welcome to REMI TranSight. Your program package includes both regional and national data 

models. The regional data and model have been calibrated to the region(s) that you specify at 

purchase, and all packages include a Windows® point-and-click interface that makes operating 

the program easy for all levels of computer users. 

 

What Is REMI TranSight? 
 

TranSight is the leading tool for evaluating the total economic effects of changes to 

transportation systems. Grounded in over 20 years of transportation modeling experience, 

TranSight provides an integrated system for comprehensive evaluation of transportation 

systems. This approach allows analysts to thoroughly describe the far-reaching economic and 

operational effects of transportation projects. As with PI+, TranSight is used by government 

agencies, consulting firms, and universities.  

Integrating economics with travel demand modeling, TranSight dynamically demonstrates how 

transportation makes economies competitive. Users can test alternative transportation changes 

and observe the short and long-term impact on jobs, income, population, and other economic 

variables. TranSight is a sophisticated modeling tool that integrates travel demand models with 

the REMI model and is constructed with extensive data on emissions, safety valuation factors, 

and other data. 

In addition to continuously improving the software and pushing the frontier of regional 

economic modeling, REMI is dedicated to providing quality customer service and support.  
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System Requirements 
 

We recommend that your computer system meet the following specifications. TranSight may 

run on systems below these minimum specs, but functioning is severely impaired.  

For standard models: 

 Windows Vista, 7, or 8 (32- or 64-bit) 

 1.4 GHz or faster processor 

 2 GB RAM 

 1024x768 display 

 2 GB of available hard-disk space 

 

For large models with 50 or more regions: 

 Windows Vista, 7, or 8 (64-bit) 

(32-bit versions of not supported.) 

 4 GB 

 2 GHz or faster processor 

 1024x768 display 

 10 GB of available disk space 

 

Simulation execution time increases exponentially with the number of regions and industry 

sectors. Large models (i.e. >12 regions) benefit greatly from increased memory capacity and 

processor speed.  For example, on a computer with a 3 GHz Intel Core 2 Duo processor and 3 

GB of RAM, a 3 region model will run a 25 year forecast in 6 seconds, while a 51-area model 

takes 14 minutes. 
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Installation 
 

IMPORTANT NOTE: You must have Windows administrative privileges to install this software. 

When you are ready to install REMI TranSight, insert the provided CD into your CD-ROM drive.  

The InstallShield installation utility should run automatically.  If it does not appear, select your 

CD drive under “Computer” in Windows Explorer and double-click “setup” or “setup.exe” to 

start the installation process.  A shortcut to the application will appear on the desktop once the 

installation is complete. 

Contact REMI or your system administrator if you need assistance with installation or operation 

of the software. 
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Starting TranSight 
 

To start TranSight, double click on the shortcut appearing on your desktop. 
 

 
 
Now you will be viewing the Home tab.  Note the default name of the workbook located on the 
header when you first open TranSight is Untitled.rwb. You will have the opportunity to rename 
this document when you save a new forecast. The name of the specific model is located on the 
status bar at the bottom of the window. The ribbon below the Home tab displays three groups: 
Add a Forecast, Views, TranSight, and About. 
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 The Workbook view is the default, and contains the Standard National Control and 
Standard Regional Control.  The Inputs view is empty until running additional forecasts, 
and the Results view gives you the option of displaying the history and forecast of any 
controls or simulations stored in the workbook.   

 The About group provides access to Model Details such as the national input output 
table and also displays a direct link to the REMI website where additional information 
and documentation may be found 

 The TranSight group contains the Travel Demand Source Editor, which is used to edit the 
bridge between TranSight and data exported from a Travel Demand Model.. 

  
To start a new simulation, click on the Regional Simulation button.  The Insert tab now appears. 
 

 
 
The Insert tab displays several groups in the ribbon. 

 The Travel Demand group allows you to change the baseline parameters used by the 
Travel Demand module as well as running the Travel Demand module itself.  The Travel 
Demand module is intended to be used with output from a Travel Demand model, but it 
is also possible to enter data manually. 

 The Transportation group organizes access to transportation-related policy variables, 
specifically Effective Distance, Multi-Modal, and Highways.  Under Highways there is 
also the Quick Study. 
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 The Blueprints, Scenarios, and List groups organize economic and demographic-related 
policy variables.  The most structured approach are available under Blueprints, a more 
moderately structured approach under Scenarios, and the least structured approaches 
in Lists. 

 Tools are available to assist with filling in values for previously selected policy variables 
(Calculator and Spreader) and Importing/Exporting policy variables to or from other 
applications. 
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Modeling a Transportation Scenario 
 
In order to model a Transportation Scenario originating from an exogenous travel demand 
model (or data entered manually), click on the Travel Demand icon. The Travel Demand Study 
dialogue will appear, displaying the available inputs.  

Travel Demand Study 

The Travel Demand Study imports the data from Travel Demand Models for use in TranSight. 
You can view Baseline and Adjusted Simulation data; the Baseline Simulation is the “no-build” 
scenario forecasting what will happen without the proposed changes, and the Adjusted 
Simulation is the “build” scenario forecasting what will happen if the changes occur. You can 
also apply different parameters to the Adjusted Simulation data, such as lower accident rates to 
reflect a build scenario that would also bring safer traffic conditions. 

It is also possible to import the same data for the Baseline and Adjusted Simulations and simply 
make Parameter Changes to see the impact it would have on your existing network. 
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Importing Data 

TranSight links travel-demand models to REMI’s economic model engine. Importing travel-
demand model information is easy, because TranSight automatically converts all the data into 
policy variables. 

1. Under the Baseline header, click on Import/Export, if it isn’t already selected. 

2. Select your travel-demand model in the Model Type drop-down list.  

 

Note: For some import types further phase-in ratios may be needed.  If that is the case an 
array to enter that data will appear below the drop-down list.  As with most tables you 
can right click on the cells to access the Calculator to assist with data entry.  

3. Click the Import Baseline Data or Import Adjusted Data button below the Model Type 
drop-down list.  This will open a new window which will either let you choose a single file 
or a folder, depending on the number of files required by the Model Type you chose.

 
4. Navigate to the folder containing your simulation data.  
5. Select it and click the Open button. 

Note:  If selecting a folder you may need to select one of the files within the folder for the 
import to work. TranSight will then convert the data into a format it can use. 

6. After import the Path to Data: line should change to reflect the file/folder you have 
imported. 

7. Repeat this process for the Adjusted Import/Export. 
 
Note: If you lack an Adjusted scenario with your Travel Demand data you can also click 
the Copy from Baseline button and manually adjust the values.  Right clicking the table 
and using the Calculator can aid in the process. 
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Enter or Adjust data manually 
 

If you do not have access to a Travel Demand model, you can manually enter your own data 
from spreadsheets.  Even with a Travel Demand model you may wish to modify data you have 
imported. 

Perform the following steps for both your baseline and/or adjusted simulation(s): 

1. Copy and Paste or type in the VMT data for each region-to-region combination, time 
period, and mode. You are entering the miles, hours, and trips per year for each year of 
the simulation.  You can right click on the table and choose the Calculator from the menu 
to assist with data entry. 

2. Repeat step 2 for all concepts (VMT, VHT, Trips) and transportation types (Highway and 
Transit) that you have data for.   

3. Once you entered your data or made your changes you may also wish to save it using the 
Save to Travel Demand File (.tdd) button on the appropriate Import/Export page.   

Baseline and Adjusted Simulations and Computed Difference 

TranSight takes the data for the Baseline and Adjusted Simulations directly from your travel-
demand model. The Baseline data should normally come from a travel-demand model 
simulation that includes no transportation projects, or otherwise represents a reference case 
against which comparisons are made to alternative scenarios. 

The Adjusted data should come from a travel-demand model simulation that incorporates one 
or more upgrades to the transportation network. 

The Computed Difference is simply the calculated difference in VMT, VHT, and VTT between the 
Adjusted Simulation and the Baseline Simulation.  To view the Calculated Differences click on 

the  Button 

 All graphed data, baseline, adjusted, and calculated, will be based on the currently 
selected dimensions (such as Road Mode and Time Period).  You can also adjust the 
layout of the dimensions on the table by right clicking on them to move them to the rows 
or columns. 

 To copy data from any of the tables to the Clipboard (so that you can paste it into another 
program, such as a spreadsheet), select the cells you wish to copy and use Ctrl+C. 

 To see more or fewer decimal digits of detail, right-click and select Precision + to increase 
precision or Precision – to decrease precision. 

 To graph the Baseline or Adjusted data simply click on the icon for the graphing tool 

.  To Graph the Calculated Differences, click on the  button. 
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By default it will display as a Line Chart.  You can also swap the Pie Chart or Bar Chart, 
although for Travel Demand data the Line Chart will usually be the most useful view. 

Right-click on a desired chart and select Copy to copy an image of the chart to the 
Clipboard; you can paste it into a graphics program such as Paint or Photoshop. 

If you have the Update checkbox checked then you can keep the chart window open and 
it will continue to reflect further changes you make to the dataset it was based on.  For 
Calculated Differences this is currently not an option due to the additional calculations 
necessary. 

The Add To Inputs List Button 

When you’re ready to add the Policy Variables created by the Travel Demand Study dialogue 

and return to the Insert ribbon, click the   button. You should now notice that 
the policy variables list has been filled with the following groups of policy variables: 

 Emissions: The change in pollution-related health costs (summed across the five major 
motor-vehicle pollutants) due to the change in VMTs caused by the transportation 
project. The Amounts tab shows the change in grams of emissions (for each of the five 
pollutants) due to the change in VMTs. 
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 Leisure Time: The value of leisure time either saved or lost due to the change in VHTs 
caused by the transportation project. A negative number on this table represents time 
(and cost) savings for that region. 

 Safety Costs: The change in accident-related costs (including health and the value of lost 
life) due to the change in VMTs caused by the transportation project. 

 Operating Costs: The change in fuel costs and non-fuel costs due to the change in VMTs 
caused by the transportation project (non-fuel costs include such factors as vehicle 
maintenance). 

 

Note that no changes to either policy variables or values may be made here, except to make 

them inactive or active by unchecking/checking the box .  Only active variables will be 
included when the simulation is run.  This option makes it easy to run multiple simulations with 
different combinations of variables included. Doing so isolates the direct impact of individual 
variables. 
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Simulation Parameters 

For a number of costs affected by transportation projects, TranSight includes data derived from 
national sources. This data includes: 

 Fuel and Non-Fuel Operating Costs. 

 Fuel Efficiency 

 Vehicle Occupancy 

 Pollutant Emissions Rates and Costs 

 Value of Time  

 Accident Rates and Costs 

You don’t need to change these values, but if you have more accurate local data it is 
recommended that you use those values instead.  To view and edit this data click Parameters 
button in the Travel Demand Inputs group on the Insert Ribbon.  When updating these 
parameters make sure the units match those specified. 
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General Group 

The General group contains importing and exporting functions as well as parameters that apply 
to all travel types: 

 Import/Export – Lets you import previously saved Parameters from a file or Export them 
for later use. 

 Emission Costs – Cost per gram for five pollutants (Volatile Organic Compounds, Nitrogen 
Oxides, Carbon Monoxide, Sulfur Oxides, and Particulate Matter). 

 Leisure Time Value– Value of Leisure Time ($US) for each model region. 

The Highway Group 

The Highway group contains parameters and advanced settings related to highway traffic: 

 Non-Fuel Operating Costs – Mileage-related vehicle maintenance in Dollars per mile by 
vehicle mode and region. 

 Vehicle Occupancy– Average Vehicle Occupancy (passengers per vehicle) by vehicle 
mode. 
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 Emission Rates – Grams per mile for five pollutants (Volatile Organic Compounds, 
Nitrogen Oxides, Carbon Monoxide, Sulfur Oxides, and Particulate Matter) by speed and 
vehicle mode. 

 Accident Rates – Accidents per million VMT by time of day categorized by Fatalities, 
Injuries, and PDO (Property Damage Only). 

 Accident Values –Accident value in $US categorized by Fatalities, Injuries, and PDO 
(Property Damage Only). 

 Fuel Costs – Fuel costs in Dollars per gallon by region and by vehicle mode categorized by 
Pre-tax Fuel Price, Federal Excise Tax, State Excise Tax. 

 Fuel Rates – Average mpg speed and vehicle mode. 

 Advanced – These are weights for specific equations in TranSight.  More details on their 
use can be found at the top of the form and by clicking on the arrow to expand the text. 

The Transit Group 

The Transit group contains parameters and advanced settings related to transit traffic: 

 Vehicle Occupancy– Average Vehicle Occupancy (passengers per vehicle) by vehicle 
mode. 

 Emission Rates – Grams per mile for five pollutants (Volatile Organic Compounds, 
Nitrogen Oxides, Carbon Monoxide, Sulfur Oxides, and Particulate Matter) by vehicle 
mode. 

 Accident Rates – Accidents per million VMT by mode and categorized by Fatalities, 
Injuries, and PDO (Property Damage Only). 

 Accident Values –Accident value in $US by vehicle mode and categorized by Fatalities, 
Injuries, and PDO (Property Damage Only). 

 Advanced – These are weights for specific equations in TranSight.  More details on their 
use can be found at the top of the form and by clicking on the arrow to expand the text.  

Exporting and Importing Parameters 

Importing the changes that you make in the various Travel Demand Parameters windows is not 
strictly required; when you change the values in these windows and click Save, TranSight uses 
these values with your current Simulation until you change them again. However, sometimes 
you may want to use your changes in a different Simulation or compare results based on two or 
more sets of values. To make this process easy, TranSight lets you export the Travel Demand 
Parameters to a file for later recall. The original settings for each tab are set whenever you 
create a new Simulation 

To save the changes you make to the values in the various Travel Demand Parameters, use 
the Export Parameters to a file button from Import/Export in the General section of the 
Travel Demand Parameters window.  This will save it to a .mcs file. 
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If you have several datasets that you’ve saved, you can select one by using the Import 
Parameters to a file button from Import/Export in the General section of the Travel 
Demand Parameters window. 

Cost Matrices 

You can also view/edit the changes to the Transportation cost matrices by clicking on the 
Effective Distance menu in the Transportation Group on the Ribbon. Next choose to edit the 
values As Transportation Cost Matrix. This will take you to the Transportation Costs Editor. 

 

There are three cost matrices you can view/edit by choosing the appropriate radio button 
below Transportation Matrices:  

 Commuter Costs - describes the amount of commuter time savings within or between 
modeled regions over the average workday. 

 Accessibility Costs - describes access to more diverse consumer goods and services by 
households, as well as access to a broader array of intermediate inputs by employers. 

 Transportation Costs - describes the amount of cost savings in transporting goods and 
services due to an increase in transportation efficiency. 

These matrices are used to calculate the amount of cost savings induced by improvements in 
the transportation network. The numbers in the table represent the percentage of savings 
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across the transportation system for specific pairs of regions (including within each region), 
relative to the baseline: 

 1 = no change from the baseline 

 Below 1 = cost savings relative to the baseline 

 Above 1 = cost increases relative to the baseline (e.g., during a construction period) 

For example, 0.99 represents a 1% cost savings across the transportation system for that region 
or pair of regions. 

You can also change the view to better allow you to see or edit the changes made. 

Once you are done making any changes to the matrices, you can click the  
button.  If you do not wish to save any changes you have made or were simply viewing the 

results of the Travel Demand Study, click the  button instead. 
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Additional Highway Inputs 

After you have run the Travel Demand study, you may wish to add additional policy variables to 
further detail the changes created by the project.  Back on the Insert Ribbon under the 
Highways button of the Transportation group there are three additional categories of data 
inputs: 

 Design and Construction  
A change in road or transit construction activity can enter the model as Demand or 
Sales/Employment. 

 Operation and Maintenance 
A change in construction activity reflecting road or transit operation and maintenance 
spending can enter the model either as Demand or Sales/Employment. 

 Government Funding 
Funding options for transportation-related projects typically involve a combination of 
several sources, including federal, state, and local governments, as well as specific 
consumer and business taxes/fees. 

For this Transportation Scenario we will include some Construction to supplement the Travel 
Demand Study inputs we created earlier.  Click on the Highways button, and select Design and 
Construction. 
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The Selector and Editor grids appear.  Give the scenario a meaningful name, such as “Highway 
Construction”. Read the scenario description for helpful information and hints applicable to the 
selection. 
 

 
 
In the Selector grid, choose from applicable groups, in this case, Construction Demand, 
Construction Sales/Employment, Professional and Technical Services Demand, or Professional 
and Technical Sales/Employment. A description of each appears in the information box. Select 
the desired Category, Detail, Region, and Units and then click the Insert Into Editor button. 
 
For this sample scenario, choose Construction Sales, Firm Sales (amount), Suburban, and 2005 
Fixed National $ (M). This is a scenario in which construction sales for particular firms in 
suburban counties change by a certain amount in millions of dollars. Read the information box 
for additional notes regarding the policy variable. When ready, click the Insert Into Editor 
button. 
 

 
 
  



21 
 

Using the Editor grid, values can be entered for each year. To assist in the entry process, the 
Spreader and Calculator tools may be helpful. The Spreader allows you to spread values across 
selected policy variables and the Calculator allows you to fill a selected range with a specific 
number in addition to calculating various types of growth and decline. Here’s how to access the 
calculator: 

1. Select a year or set of years in the editor grid. The Calculator function now becomes an 
available tool. Click the Calculator. The Row Calculation window opens. 

 

2. Select the function you wish to use by clicking on the appropriate tab.  
3. Enter the values for the given calculation type. 
4. Click on OK, and the numbers in the selected cells change accordingly. 

The Row Calculation tabs are defined below. 

 Fill Range—Enters the same number in each of the selected cells. For example, if you 
enter 50, then the number 50 would appear in each cell in your selection. 

 % Change—Changes the selected cells by the percentage that you enter.  

  Value—Changes the selected cells by the number you indicate. For example, if you 
entered 10, the program adds 10 to the number in each cell. 

 Linear (Interpolate Rows)—Select this option to have the system work with your 
beginning and endpoint values for a particular row. For example, suppose that for a 
particular TranSight variable you have target values for every fifth year. Use this option to 
assign yearly values linearly interpolated between the five-year targets. 

 Exponential (Interpolate Rows)—Select this option to have the system work with your 
beginning and endpoint values for a particular row. Unlike linear interpolation, the 
function determines a geometrical growth rate between the endpoints, and distributes 
the change between those two points geometrically. 

 Annualize—Calculates the annualized payments required to pay the amount borrowed at 
a given interest rate for a fixed number of years. To use this option you need to enter the 
number of years over which the payments are to be made (or choose “Selected Years” if 
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the highlighted range reflects this number), the value being financed, and the interest 
rate. The rate is entered as a percent. 

 
For this scenario, we simply want to fill the value 10 from the Start Year of 2010 to the End Year 
of 2015. Make these changes and click OK. 
 

 
 
10 should be filled in the Editor Grid representing a 10 million dollar increase in Construction 
Sales in suburban regions for 2010 to 2015.  
 

 
 

If this is the only desired policy variable change, click the  button at the 
bottom of the screen. The Policy Variable Inputs view now displays the Construction Sales 
policy variable that was just entered and the Travel Demand Scenario added earlier. 
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Note that no changes to either policy variables or values may be made here, except to make 

them inactive or active by unchecking/checking the box .   
Only active variables will be included when the simulation is run.  To go back and edit policy 

variables or their values, click on the edit button , which will take you back to the 
Selector/Editor grid. 
 
 It is a good idea to give the forecast a meaningful name by changing the text in the text box 
labeled Forecast Name.  This will make it easier to identify this simulation while you are in the 
Workbook view.  For this example, we will use “Highway Simulation 1”. 
 
You may also determine the appropriate baseline which the simulation will be compared to (the 
Standard Regional Control is the default and only option unless the user has created other 
alternatives). Also, determine the length of the forecast to be run (2050 is the default).  
 

 
 

When ready to run the simulation, click the  button. A status bar displays stating the 
elapsed time and estimated time remaining. Models with a small number of regions will run in 
only a few seconds on a fairly fast computer. 
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When the forecast has completed running, the Results tab appears.  
 

 
 
It is helpful at this time to maximize the application display so it fills your monitor screen, if you 
have not already done so. 
 

 
 
The default view shows Summary concepts displayed as both a table and a line chart. The 
Display group on the far left of the ribbon also provides a map view for multi-region models. 
One, two, or all three views may be activated at a time.  
 

 The Display group also has buttons for adjusting 
decimal precision, chart type, and allows pivoting 
of the data to rearrange the layout of the grid. 

 

 The Data group provides buttons for viewing the 
data as levels, percent change, or differences. It also 
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allows the Years, Regions, and Forecasts viewed to be adjusted. 
 

 The Results Tables group presents several 
categories of tables to view. Under Economic 
one can find all of the model’s economic 
variables in organized tables. Under 
Demographic one can find all of the model’s demographic concepts in organized tables. 
Custom Tables allows you to edit and create tables according to your own needs.  It is 
also possible to view tables related to the Model Linkages diagram, DevSight, and 
several Extras, such as Analytical Graphs.  

 

 The Export group allows you to save a table to another 
format for easy import into other applications, such as a 
spreadsheet. 

 
When done viewing the simulation results, close the Results tab window by clicking on lower X 
in the upper right hand corner.  
 

 
 
Then close the Insert tab window by clicking again on the lower X in the upper right hand 
corner. You will be prompted to save the forecast to the workbook. Click Yes. 
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Then you will be prompted to give the workbook a name, such as Highway Study. Then click the 
Save button. 
 

 
 
Your Workbook view will now display the Highway Study simulation labeled Highway 
Simulation 1.   
 

 
 
To reexamine the policy variable inputs, simply double click on the Policy Change box of the 
flow chart.  To reexamine the simulation results, double click on Highway Simulation 1 box.  
 
Likewise, the Standard Regional Control and Standard National Control data may be viewed by 
double clicking on those respective boxes. 
 
To close the application, click on the top X in the upper right hand corner. 



27 
 

 

 
 
To start over, click the File  Tab and select New. Then decide whether you want to save the 
simulation before starting over. 
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Modeling an Economic Scenario 
 
To model an Economic Scenario, such as a plant shutdown, click on the Scenarios button, and 
select Employment & Sales. 
 

 
 
The Selector and Editor grids appear.  Give the scenario a meaningful name, such as “XYZ Plant 
Shutdown.” Read the scenario description for helpful information and hints applicable to the 
selection. 
 

 
 
In the Selector grid, choose from applicable groups, in this case, Firm Behavior or Industry 
Behavior.  A description of each appears in the information box. If you know that XYZ is a 
manufacturing company, but you are not sure whether or how much it supplies the local 
region, choose Firm Behavior. 
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In the Category box, choose Firm Employment, since for this simulation we will assume we 
know the number of direct jobs being lost.  This selects the specific policy variable to be 
changed.  Read the information box for additional notes regarding the policy variable. In the 
Detail box, select the industry that XYZ is classified as.  In this example, assume it is Machinery 
manufacturing. In the Region box, select the region where the plant is located, which is Urban 
Counties.  In the Units box, select the appropriate units matching your inputs, in this case Units 
(number of individual jobs).  
 

 
 

When ready, click the Insert Into Editor button.   The Editor grid now displays 
the policy variable selected. Enter job losses, with a negative value, by year. Since the value will 
be constant throughout the forecast period to reflect permanent job losses, the calculator may 
be used to automatically fill in the values for all years. 
 

 
 
  



30 
 

 To do this, highlight the range of cells, in this case 2010-2060, and click on the Calculator 
button on the Tools group of the ribbon. Enter the value to be filled in each year, in this case -
675 (for a job loss of 675 employees).  Then click OK. 
 

 
 
The Editor grid is now filled with a time series of the value entered. 
 

 
 
If this is the only desired policy variable change (perhaps because it is the only input 

information available), click the  button at the bottom of the screen. 
 
The Policy Variable Inputs view now displays, listing the policy variable category just created.  
Click the expand button (+) to see the details. 
 

 
  
 
 
In this example, only one policy variable is listed.  If multiple variables had been selected, then 
would also be listed here.  Note that no changes to either policy variables or values may be 

made here, except to make them inactive or active by unchecking/checking the box .   
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Only active variables will be included when the simulation is run.  To go back and edit policy 

variables or their values, click on the edit button , which will take you back to the 
Selector/Editor grid. 
 
It is a good idea to give the forecast a meaningful name by changing the text in the text box 
labeled Forecast Name.  This will make it easier to identify this simulation while you are in the 
Workbook view.  For this example, we will use “XYZ Plant Shutdown”. 
 
 You can determine the appropriate baseline which the simulation will be compared to (the 
Standard Regional Control is the default and only option unless the user has created other 
alternatives). Also, determine the length of the forecast to be run (2060 is the default). 
 

 
 

When ready to run the simulation, click the  button.  A status bar displays stating 
the elapsed time and estimated time remaining.  Models with a small number of regions will 
run in only a few seconds on a fairly fast computer. 
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When the forecast has completed running, the Results tab appears.  
 

 
 
It is helpful at this time to maximize the application display so it fills your monitor screen, if you 
have not already done so. 
 

 
 
As was described in the previous simulation, the default view shows Summary concepts 
displayed as both a table and a line chart. The Display group on the far left of the ribbon also 
provides a map view for multi-region models. One, two, or all three views may be activated at a 
time.  For further details on what the elements of these groups do, please review the previous 
section Modeling a Transportation Simulation.  
 
When done viewing the simulation results, close the Results tab window by clicking on lower X 
in the upper right hand corner.  
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Then close the Insert tab window by clicking again on the lower X in the upper right hand 
corner. You will be prompted to save the forecast to the workbook. Click Yes. 
 

 
 
Then you will be prompted to give the workbook a name, such as XYZ Plant Shutdown. Then 
click the Save button. 
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Your Workbook view will now display the XYZ Plant Shutdown simulation.   
 

 
 
To reexamine the policy variable inputs, simply double click on the Policy Change box of the 
flow chart.  To reexamine the simulation results, double click on the XYZ Plant Shutdown box.  
 
Likewise, the Standard Regional Control and Standard National Control data may be viewed by 
double clicking on those respective boxes. 
 
To close the application, click on the top X in the upper right hand corner. 
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Other Features and Usage Tips 

Cumulating Policy Variables and Understanding Results 
 
Introducing one policy variable at a time into a simulation facilitates understanding how the 
specific choice and magnitude of the input affects the net results. This may be especially useful 
when there are different or offsetting components that make up the analysis. 
 
This process is best illustrated with a simple example. Say a state or local government is 
considering increasing its general level of services and plans to finance this with an increase in 
personal taxes. Running these two policy variables together will generate the net results, but 
this will not necessarily give the analyst a feel for the magnitude of the positive impact of the 
new spending versus the negative impact of the new taxes. By running the simulation in a 
cumulative fashion, the individual effects as well as the net effects can be understood. 

Selecting and Activating Variables 
 
Step 1: Start a new Regional Simulation. Click the Topics button on the Insert tab ribbon, and 
select Government Spending. In the Selector grid, click on Government Spending (amount), 
choose the Urban Counties region.  Then choose the appropriate units, in this case 2014 
Chained National $ (M). Click Insert into Editor, and enter a value of 100 for each year for 10 
years, beginning in 2014 ($100 million per year from 2014-2023.   Then click the Add to Inputs 
List button. 
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Step 2: To add the second policy variable, click the Topics button on the Insert tab ribbon and 
select Consumer Taxes.  In the Selector grid, click on Personal Taxes (amount), choose the 
Urban Counties region.  Then choose the appropriate units, in this case 2014 Chained National 
$ (M). Click Insert into Editor, and enter a value of 100 for the same years as the last policy 
variable (2014-2023).   Then click the Add to Inputs List button. 
 

 
 
Step 3: The Policy Variable Inputs View shows both policy variables. For the first simulation, we 
want to run one alone, so deactivate the Personal Taxes policy variable by unchecking the 
active box. Name the forecast, in this case, $100M Government Spending Alone, and set the 
run to year to 2023 since we are only interested in a 10 year time horizon. 

 

 
 

Then click the  button. The results show the effect of the additional government 
spending only, which leads to positive employment changes. 
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Step 4: Close and save this forecast to a new workbook. The Workbook view now shows the 
saved simulation.  To copy the policy variables already selected to a new simulation, right click 
on the Policy Change box.  This will open a menu with several options, choose Duplicate. 
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This will open an input box prompting for the name of the duplicated simulation.  Give the 
simulation a meaningful name, in this case, $100M Government Spending with Tax Increase 

 
 
and click OK.  A new forecast branch is now visible. The new forecast name is currently ghosted 
because the forecast has not yet been run. 
 

 
 
Step 5: Double click on the new Policy Change box in order to access the Policy Variable Inputs 
window.  Since an exact copy of the policy changes from the first simulation was made, the 
Additional $100M Personal Taxes policy variable is still inactive.  To active this variable, click on 
the check box.  

 
Change the run to year to 2023 (if it is not already the year displayed) and click Run Now. 
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The results now displayed are net for both the additional $100M of new government spending, 
and the additional $100M of new personal taxes.  
 

 
 
Step 6: You are now ready to analyze the results. To see the effect of just the increase in 
personal taxes, click on the Forecast button on the Data group of the Results tab ribbon, and 
select the Government Spending Alone forecast for comparison. Click OK. 
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The Results now reflect just the additional taxes, which leads to a loss of jobs. 
 

 
 
By going through the policy variable selection process just once, you have been able to 
generate results for three different simulations: government spending alone, government 
spending combined with additional personal taxes, and personal taxes alone. Each policy 
variable generates a change in many of the endogenous variables of the model and it is 
important to be able to understand how the final results of a simulation are influenced by the 
specific policy variables that are used. By seeing the effects of each policy variable change, you 
will be better able to explain the final result when all of the variables are combined. 
 

Using Analytical Graphs to Understand Results 
 
Analytical Graphs are organized to illustrate the main determinants of key variables of the 
model.  By stepping through the graphs, you can quickly see the percent change in a key 
variable as well as that variable’s main determinants, allowing you to isolate the primary cause 
and effects of the simulation changes.  Analytical Graphs can be found in the Results Tables 
group under Extras and selecting Analytical Graphs. 
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Looking at the $100M Government Spending with Tax Increase simulation (compared to the 
Standard Regional Control), the State and Local Government Spending Determinants chart 
illustrates the total percent change to State and Local Government Spending, which is a 
combination of both the direct $100M input as well as the indirect effect of a slightly higher 
population and economy (measured in Total GDP). 
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The effect on employment can be explained by viewing the Total Employment Components 
chart. A change in government employment leads the way, which is logical since the direct 
input was additional government spending, most of which, on average, is used to support 
employment. The change in Private Non-Farm Employment is the indirect effect of the 
additional government spending. 
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To better understand the change in Private Non-Farm Employment, you can look at the Private 
Non-Farm Employment Components by Demand Source chart, which shows the percent 
change in employment by type of demand. Consumption and Intermediate Demand are 
typically the largest components of demand, so these changes track the most closely to the 
overall change in Private Non-Farm Employment. The additional government spending led to an 
increase in consumption primarily due to the spending of compensation earned by the new 
government employees. The intermediate demand increased due to additional demand by 
consumers as well as direct spending of the government on supplies, etc.   
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Looking at the $100M Tax Increase Alone simulation (compared to the Standard Regional 
Control), the Real Disposable Personal Income per Capita Determinants chart illustrates the 
total percent change to Real Disposable Income, as well as the percent change in Real 
Disposable Income per Capita, which is also affected by the percent change in Population. 
Increasing personal taxes leads to additional outward flow of economic migrants (due to the 
increased cost of living in the area), which lowers the overall population, mitigating the percent 
change in Real Disposable Income per Capita compared to the percent change in Real 
Disposable Income. 
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The Consumption Determinants chart shows the percent change in Consumption, as well as 
the primary causes for this, Population (by age cohort) and Real Disposable Income per Capita. 
A smaller population and less income per person result in less consumption. 
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The Final Demand Components chart shows the percent change in major components of GDP. 
The overall negative effect on the economy (driven by less consumption) leads to less fixed 
investment over time, due to a smaller optimal capital stock.  
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The effect on employment can be explained by viewing the Total Employment Components 
chart. Private Non-Farm Employment shows the largest decrease in terms of percent change. 
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The overall loss of jobs is primarily explained by the decrease in demand for Consumption, 
Investment, and Intermediate goods. 
 

 
 

Moving the Tables to a Spreadsheet 

To make more complex adjustments to several cells, move the data to a spreadsheet 
application. 

1. Open your spreadsheet application (we use Microsoft Excel for demonstration purposes). 
2. Switch to TranSight. 
3. Select the cells you want to work with. 
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4. Press Ctrl-C (or right-click and select Copy) to copy the cells.   To also copy the row and 
column headers press Ctrl-N (or right-click and select Copy with Names) 

5. Switch to Excel. 

Press Ctrl-V (or right-click and select Paste) to paste the cells into Excel. 

 

6. Modify the cells as needed. 

 

7. Select the cells in Excel. 
8. Press Ctrl-C to copy the cells. 
9. Switch to TranSight. 
10. Place the cursor in the topmost or leftmost of the cells you moved to Excel. 

 

 

11. Press Ctrl-V or right-click and select Paste to paste the cells back into TranSight. 

Note position of cursor 



50 
 

 

 

Getting Additional Help 
 
Help is available in the following forms: 

 REMI Technical Support 

 REMI’s Web site, www.remi.com 

Contacting REMI Technical Support 
 
You may contact REMI Technical Support at 413-549-1169. Be sure to be sitting near your 

computer so a REMI support person can help you with your problem. 

REMI’s Web Site 
 
REMI’s Web site, www.remi.com, contains a Frequently Asked Questions (FAQ) page, a glossary 

of terms, and extensive product documentation.  There is also a listing of upcoming REMI 

conferences. You can also contact a member of the REMI staff anytime by sending an e-mail to 

info@remi.com. 

 

http://www.remi.com/
http://www.remi.com/

